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1 Introduction 
This document describes the installation and use of Keynote’s MITE (Mobile Internet Testing 
Environment) Enterprise for UFT (HP Unified Functional Testing, which includes HP QTP—HP QuickTest 
Pro). 

MITE Enterprise for UFT provides access to over 2100 emulated devices and 12000 device profiles within 
HP QTP. Users can test and verify mobile web content availing of Keynote’s design and performance 
metrics. Users can also record test scripts on real WebKit browsers for on-demand playback.  

Mobile web site interaction, test script recording and playback all take place within HP QTP. Test scripts 
and results are stored within HP QTP. 

1.1 Document Outline 
This document assumes that you are familiar with interacting web sites using MITE emulators and 
interpreting performance evaluation data displayed in MITE results. 

In this document: 

Introduction covers requirements for installing and running MITE Enterprise for UFT. 

Installation covers the procedure of running the MITE UFT Configurator to install the MITE Add-in. 

Running MITE Enterprise for UFT covers starting and stopping a session and adjusting the Keynote MITE 
window. 

Browsing covers how to navigate web content and interpret MITE performance data. 

Creating a MITE for UFT Test Script covers recording a script, the objects captured, and inserting a 
checkpoint. 

Execution and Results covers how to run a script on one or multiple devices and view HP QTP as well as 
MITE results. 

1.2 Requirements 
To deploy MITE Enterprise for UFT, you need to install:  

 HP QTP or HP UFT software 11.00—refer to the HP QuickTest Professional Installation Guide for 
system requirements. 

 Keynote MITE 4.0 

When you install and launch MITE, it automatically detects if HP QTP is installed on your machine 
and prompts you to start the UFT Configurator.   

This guide assumes that you familiar with HP QTP as well as browsing websites, recording and playing 
scripts, and reviewing results in MITE. 

1.2.1 Minimum System Requirements 
In order to install MITE and the MITE Add-in, and run HP QTP with the MITE Add-in, you require: 

Hardware/Software For Requirement 

Operating system Installing MITE and MITE Add-in  Windows XP SP2  
 Windows 7 
 Windows 8 

Processor Running HP QTP with MITE Add-in  Pentium IV (1 Ghz) or higher 
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Hardware/Software For Requirement 

Memory Running HP QTP  1 GB when no more than 3 add-ins are loaded 
simultaneously 

 Additional memory is required to load more 
add-ins or to capture movies during run 
sessions.  

Disk space Installing HP QTP  1 GB for application files and folders 
 Additional 120 MB of free disk space on the 

system disk 

Installing MITE and MITE Add-in  200 MB  

Video Running HP QTP with MITE Add-in  Graphics card with 64 MB video memory 
 High Color (16 bit) color setting 

Network Running HP QTP with MITE Add-in  Internet connection required for logging in and 
navigating web sites. 

1.3 Documentation and Support 
Help for using MITE can be found at http://www.keynote.com/support/mite3_help/.  

Keynote Technical Support can be reached at http://www.keynote.com/support/.  

 

http://www.keynote.com/support/mite3_help/
http://www.keynote.com/support/
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2 Installation 
The high-level process of installing the MITE Enterprise for UFT testing environment involves: 

1. Installing HP QTP 

2. Installing MITE 

3. Launching MITE at least once (covered below) 

4. Stepping through the UFT Configurator to install the MITE Add-in (covered below) 

5. Launching HP QTP and selecting the MITE Add-in 

2.1 UFT Configurator 
This section describes the simple procedure stepping through the UFT Configurator wizard to install the 
MITE Add-in for HP QTP. 

1. After you have installed MITE, launch the program at least once (you do not need to log in) to 
complete installation of required files in your Windows user profile directory.   

2. If MITE detects HP QTP on your machine, it automatically prompts you to start the UFT 
Configurator—click Yes to continue. 

 
Or you can launch it from Start > All Programs > Keynote Systems > UFT Configurator. 
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3. Click Next to advance through the wizard. 

 
4. Enter your credentials and click Log in. 
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5. You can click Next when your credentials have been authenticated. 

 
6. The next screen shows you instructions for what to do after you click Finish to exit the wizard. 
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7. Launch HP QTP and verify that you can see the MITE Add-in listed. 

 

2.2 File Locations 
User-specific information and files, including log information, are saved to user profile directories in 
Windows:  

 Windows XP: C:\Documents and Settings\<Windows_user_name>\Local 
Settings\Application Data\Keynote Systems\Mite 

 Windows 7 and 8: C:\Users\<Windows_user_name>\AppData\Roaming\Keynote 
Systems\Mite 
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3 Running MITE Enterprise for UFT 
MITE Enterprise for UFT provides a full-featured interface within HP QTP for browsing and testing mobile 
web content with a real WebKit browser. 

This chapter explains how to start and stop a MITE for UFT session and describes the Keynote MITE 
window for emulated mobile web browsing and testing. 

3.1 Starting and Stopping a Session 
Test & verify mobile Web content with a real WebKit browser 

1. Launch HP QTP and select the MITE Add-in. Click OK. 
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2. Enter your MITE credentials in the Keynote MITE window and click Login. 

 

NOTE You can be simultaneously be logged in to a standalone instance of MITE as well as MITE 
Enterprise for UFT using the same credentials. 

To exit a MITE for UFT session simply exit HP QTP (File > Exit). 

If HP QTP quits unexpectedly, the MITE Add-in is not terminated. You need to terminate the following 
processes manually from the Windows Task Manager: 

 MITEPlug.exe  

 MWPRunnerForm.exe  

 BrowserRunnerForm.exe  

3.2 Keynote MITE Window 
When you log in to MITE for UFT, you are directed to the device library, from where you can choose from 
a vast database of emulated devices and device profiles. 

At any point after logging in, you can close/display the window by navigating to View > Keynote MITE. 

To float the window, click the title bar and drag it. You can also click the arrow in the top-right corner of 
the window and select Floating.  
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Figure 3-1 Controls to Float or Dock the Keynote MITE Window 

 
You can dock the window in any quadrant of the HP QTP window:  

1. Click the title bar of the window and drag it. 

 
2. Dragging the window, mouse over any of the docking arrows that appear. The corresponding 

quadrant is highlighted. 

 
3. Release your mouse button. The Keynote MITE window is docked in the chosen quadrant. 
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4 Browsing 
This chapter covers how to browse and interpreting MITE data in the performance waterfall, captured 
DOM tree, and the MITE score. 

As in MITE, you can choose from a large database emulated devices and device profiles to browse live 
mobile web content in MITE Enterprise for UFT.  

A device profile is a unique combination of device model, OS version, and browser. For a given device, 
profiles can vary with respect to Internet properties such as the HTTP header set or the number of 
simultaneous TCP connections.  

The image below shows the device models available for a manufacturer as well as the profiles available 
for a selected device model. 

Figure 4-1 Device Models and Profiles 

 

4.1 How to Browse 
To browse a website: 

 Select a device or device profile from the device library, then click the Browse  button to specify a 
website, or 

Selected device 
model 

Profiles available for 
selected device model 

Device properties 
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 Click the Browse  button and select a device as well as URL to navigate to. 

Figure 4-2 Browse Dialog Box 

 
Advanced settings allow you to emulate a specific location, specify caching information, change device 
orientation, and enter credentials to access a website. 

Figure 4-3 Advanced Browse Settings 

 
You can click, scroll, and enter data just as you would on a real device in the MITE Browser window that 
opens up. Simply close the MITE Browser window to stop browsing. 

4.2 Performance Waterfall and Object View 
The Performance waterfall in the default Performance view shows the download sequence and relative 
download speed and size of downloaded elements for each interaction (click or field entry).  
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Figure 4-4 MITE Browser Window—Default View 

 
Elements are listed in the order in which they are downloaded. The blue bar for an element in the 
waterfall represents an HTTP request. The width of the bar represents the time taken to process the 
request; the green bar represents object size.  

Figure 4-5 Interpreting the Waterfall 

 

Note Waterfall charts with a green background (as in Figure 4-5 above) depict the most recent HTTP 
requests. 

Select an element in the waterfall and switch to the Object view to see its details.  

HTTP 
request Object 

size 
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Figure 4-6 Object View 

 

4.3 DOM Tree View 
In the DOM tree view, any node you select in the tree is highlighted on the device screen. The CSS 
applied to the node, whether from the DOM or an external source, is shown in the bottom pane. 

 
In addition to searching the DOM tree by XPath and a text string, you can also enter a CSS query. Select 

Search CSS and click the DOM search button .  

Element selected in  
waterfall 

Element (image) 
displayed in 
Object view 

Highlighted on device screen 

Selected node 

CSS applied to selected node 
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Figure 4-7 Searching the DOM by CSS 

 

All nodes that match the query are displayed in bold. Use the next/previous buttons  to select each 
search result in turn. The corresponding area of the device screen is highlighted. 

Figure 4-8 CSS Search Results 

 

The spy button  at the top-right of the DOM tree view is another search tool. When you select the spy 

button , navigation is effectively frozen and any element you click on the device screen is highlighted 
in the DOM. 
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Figure 4-9 MITE Spy Tool 

 
Deselect the MITE spy button to resume navigation. 

4.4 MITE Score 
Each page navigated to is given a MITE score by evaluating its performance based on Keynote’s 
algorithm for performance best practices. 

Figure 4-10 MITE Score 

 
The MITE score tab has panes for the assigned score, a list of performance indicators from which you 
can select an indicator, a description of the indicator, and its details.   

Highlighted 
in DOM 

Selected element 

Spy tool enabled 

Selected performance 
indicator from list of 

factors Details of 
selected 
indicator 

Performance 
score 

Description of indicator 
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5 Creating a MITE for UFT Test Script 
You can record a script using the HP QTP Record button and then interacting directly with web content. 
At a high-level, recording consists of these two steps, performed in any order: 

 Click Browse  to specify a device and a website to navigate to. 

 Click the HP QTP  button. 

NOTE All MITE for UFT scripts are stored within HP QTP; these scripts are not compatible with 
standalone installations of MITE and cannot be imported to MITE. 

This chapter covers recording a script, the objects captured, and inserting a checkpoint. 

5.1 Recording a Test Script 
This section walks you through the creation of a test script. 

1. Set up Active Screen capture as part of your recorded test script: 

a. Navigate to Tools > Options > Active Screen. 

b. Select Custom Level. 

 
  



MITE Enterprise for UFT   Installation and User Guide 

20 Keynote Confidential 

c. Scroll down to MITE Add-in and select Complete. 

 
d. Click OK twice to exit Active Screen settings. 

2. Click the Record button  in HP QTP to switch to recording mode.  

3. Click OK in the Record and Run Settings dialog box. 

 

4. Click the Browse button . 



Installation and User Guide  MITE Enterprise for UFT  

 Keynote Confidential 21 

5. Select a device and a URL to navigate to in the dialog box that appears and click OK. The options 
selected in this dialog box are recorded as properties of the MITE Browser object created. 

 
6. In the MITE Browser window, click, make selections, and enter data to interact with web content. 

As you perform the following actions, corresponding HP QTP test steps are inserted (see Figure 5-1 
below): 

 Clicking on links 

 Selecting a value using a drop-down list, radio button, or check box 

 Entering a value into a field 

Generally, one test step is inserted per click or field entry. 

7. Click Stop to finish recording. Closing the browser window will not stop recording. 

Figure 5-1 Script Recording in Progress 

 

Recorded 
test steps 

Browser 
window 
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5.2 MITE Objects in HP QTP 
Recording a MITE script creates a hierarchy of HP QTP objects, which are referred to in test steps.  

5.2.1 MITE Browser Object 
At the top of the hierarchy is the MITE Browser object, whose properties include the opening URL and 
details of the device profile selected. There are also several properties defining completion events for the 
starting URL. 

Figure 5-2 MITE Browser Object in Repository 

 

Table 5-1 MITE Browser Object Properties 

Field Description 

uasuffix User agent suffix for each HTTP request—this can help filter MITE 
traffic from your web server logs. The string is appended to the user 
agent string. 
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Field Description 

uastring User agent string that identifies browser, device OS and version, 
browser platform; one of the headers sent to the server 

saverun If set to True, stores MITE run results in HP QTP. If set to False, 
MITE results do not persist after the session ends. 

openurl Based on a setting in the browse dialog box—URL to navigate to 

longitude Used to identify the emulated location from which the web server 
request is sent latitude 

kdaobjectid Unique object identifier used by HP QTP 

eop_onurlcount_urlcount URL count to download before a page is considered complete 

eop_onurlcount_endonurl 
count 

If set to True, a certain number of URLs downloaded signify the end of 
the page (this number is specified in eop_onurlcount_urlcount). 

eop_onurl_urlval URL to be detected; signifies the end of page. 

eop_onurl_endonurl If set to True, the end of a specific HTTP request to a URL signifies 
the end of a page. The URL is specified in eop_onurl_urlval. 

eop_oncontent_waitcontent 
todisappear 

If True, waits for text defined in eop_oncontent_text to appear; if 
False, waits for the text to disappear for page completion. 

eop_oncontent_text If the text string specified appears/disappears, MITE considers the 
page complete.  

eop_oncontent_locationindom Searches for eop_oncontent_text in the specified element in the 
DOM. 

eop_oncontent_endonspecific 
content 

If True, waits for specified content to appear/disappear in order to 
consider a page complete. 

eop_httpinactivity_timeout Time in milliseconds after which, if there is no HTTP activity, the page 
is considered complete—this value is set to 2000 by default. 

eop_httpinactivity_endon 
httpinactivity 

If set to True, calculates page completion based on 
eop_httpinactivity_timeout. This is the default page 
completion criterion. 

eop_endonloadevent Considers the end of the page to be reached when the browser notifies 
the completion of download (set by default to True). 

deviceid Internal ID in the MITE device database of the emulated device 

clearlocalstorage Based on a setting in the browse dialog box—clears browser local 
storage (recent searches, etc.) before a test run or browse session 
begins. 

clearcache Based on a setting in the browse dialog box—clears browser cache 
before test run or browse session begins. 

NOTE When using end of page criteria, all must be met to signify page completion. For example, by 
default, both eop_httpinactivity_endonhttpinactivity and eop_endonloadevent are set to 
True, implying that both conditions must be met for page completion. 

5.2.2 Page Object 
Each page navigated to creates a corresponding page object. Page objects are children of the MITE 
Browser object. All actions such as clicks performed on the page create child objects of the page object. 
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In addition to kdaobjectid, the page object, gmail.google.com in Figure 5-3 below, has page 
completion properties, in case the Back() or Forward() methods are invoked when editing a script in 
Keyword or Expert mode. These properties are defined in Table 5-1 above.  

Figure 5-3 Page Object in Repository 

 

5.2.3 Click Action Object 
When you click any point on a web page, a corresponding object is created as a child of the page object. 
A test step with the MITEWebElement() method referring to the object is inserted in the test script. In 
the sample script line below, the object is WebElement Name: signIn.  

MITEBrowser("MITE Browser").MITEPage("gmail.google.com"). 
MITEWebElement("WebElement Name: signIn").Click "signIn","",1,"" 
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Figure 5-4 Click Action Object in Repository 

 
Table 5-2 below describes object properties that identify the element selected. MITE for UFT navigates to 
an element using the name, URL, access key, or position (elt_position), in that order. The name can 
also use the extended syntax to point to an element using map.select:{XPath of the element}. 
Other properties for the end of page are described in Table 5-1 above.  
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Table 5-2 Click Action Object Properties 

Field Description 

elt_xpath Path expression identifying the selected element in the DOM 

elt_width Width of the element in pixels 

elt_url URL, if any, of the link clicked 

elt_top Ordinate coordinate in pixels of the element clicked 

elt_text Text of the selected element 

elt_tagname Tag name of the element selected 

elt_style  

elt_position Number indicating position of the link with regard to other clickable 
links—clickable links are counted from the top left of the device screen. 

elt_parent_url URL of the parent element 

elt_parent_tag Tag name of the parent element 

elt_parent_id id attribute of the parent element 

elt_parent_class class selector of the parent element 

elt_name Name of the link/element clicked  

elt_left Abscissa coordinate in pixels of the element clicked 

elt_id id attribute of the selected element 

elt_height Height of the element in pixels 

elt_class class selector of the element selected 

elt_accesskey accesskey attribute of the link clicked 

5.2.4 Select Action Object 
When you select a value using a check box, radio button, or drop-down list, a corresponding object is 
created as a child of the page object. A test step with the MITEWebSelect() method referring to the 
object is inserted in the test script. In the sample script line below, the object is WebElement Name: 
NumberOfAdult and refers to a pick list for the number of passengers on an airline booking page.  

MITEBrowser("MITE Browser").MITEPage("Book Your Flight"). 
MITEWebSelect("WebElement Name: NumberOfAdult"). 
Select "Adults: 2 Travelers","NumberOfAdults","2",3 

The object properties that identify the selected value are: 

Table 5-3 Select Action Object Properties 

Field Description 

select_value Value chosen—if a radio button or check box, 1 = select, 0 = unselect 
2 in the example above 

select_option Option that the value corresponds to (Adults: 2 Travelers in the example above) 
This object has the same end of page and element identifying properties described in Table 5-1 and 
Table 5-2, respectively. 
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Figure 5-5 Select Action Object in Repository 

 

5.2.5 Input Action Object 
When you enter a value in a field, a corresponding object is created as a child of the page object. A test 
step with the MITEWebInput() method referring to the object is inserted in the test script. In the sample 
script line below, the object is WebElement Name: Email and refers to email ID entry field on the 
Gmail sign-in page.  

MITEBrowser("MITE Browser").MITEPage("gmail.google.com"). 
MITEWebInput("WebElement Name: Email").Set "name@email.com","Email",12 
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Figure 5-6 Input Action Object in Repository 

 
The object properties that identify the entered value are: 

Table 5-4 Select Action Object Properties 

Field Description 

input_value Value entered—if encrypted, the value is not displayed as entered to ensure that it 
is not readable. 

input_isencrypted Indicates whether the value is encrypted; 0 = not encrypted, -1 = encrypted 

This object has the same end of page and element identifying properties described in Table 5-1 and 
Table 5-2, respectively. 
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5.3 Checkpoints 
MITE for UFT supports standard HP QTP checkpoints for script verification. 

To insert a checkpoint, while still in record mode: 

1. Select Insert > Checkpoint > Standard Checkpoint. 

The main HP QTP window is minimized while the MITE Browser window becomes the active window. 

2. Click anywhere on the device screen to select the corresponding element as a checkpoint for the 
page.  

3. If there is a valid element where you have clicked, HP QTP translates it into a child object(s) of the 
browser and page objects. Select the correct object from the dialog box that appears and click OK. 

 
4. In the Checkpoint Properties dialog box, check the properties you want to use to identify the element 

at run time. 

5. Be sure to specify a timeout (in seconds) within which the checkpoint must be found. Click OK. 

 
A test step referencing the object created (WebElement TagName: A in the example below) is 
inserted into your script.   
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MITEBrowser("MITE Browser").MITEPage("United Airlines_2"). 
MITEWebElement("WebElement TagName: A"). 
Check CheckPoint("WebElement TagName: A") 

The object is listed in the Checkpoint and Output Objects section of the object repository. Properties 
identifying the selected element are described in Table 5-2. 

Figure 5-7 Checkpoint Object in Repository 
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6 Execution and Results 
This chapter describes how to run a MITE for UFT test script and view HP QTP results as well as MITE 
results with waterfall graph and MITE score. It also covers running a script on multiple device profiles.  

6.1 Running a Test Script 
With your MITE for UFT script open: 

1. Open the MITE for UFT script you wish to execute. 

2. To save MITE run results that include the MITE score and waterfall graph: 

a. Open the object repository: Resources > Object Repository. 

b. Select the MITE Browser object. 

c. Set the saverun property to True. Close the object repository. 

 

MITE results are then accessible at any time after the run by accessing the test list  and run 

results  layouts. 

3. Run the script by selecting Automation > Run or clicking the Run icon . This executes the 
script on the device it was recorded on. 

NOTE If you need to, insert a wait time of a few seconds, e.g., Wait 15, before the first execution of 
your script so you can position the HP QTP window. You can delete the line for subsequent runs as 
the window position is automatically remembered. 
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4. When prompted, specify a location for your HP QTP test results. 

 
While the test is running, the yellow arrow indicates the test step currently being executed. A 
notification at the base of the HP QTP window indicates that the script is running. 

 

6.2 Viewing Results 
When you have executed a script, you can view standard HP QTP results in the HP Run Results Viewer. 
These are automatically stored to the location specified. You can also view MITE results with detailed 
performance metrics. If you set the saverun property of the script’s MITE Browser object to True, MITE 
results persist after your HP QTP session; if not MITE run results are not available after you close the 
current session. 

Test step currently 
being executed 

Execution 
notification 

Window for viewing 
test execution on web 
content 
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6.2.1 HP QTP Results 
The HP Run Results Viewer is automatically displayed after script execution. Expand the tree on the right 
to see all script nodes (objects). The top node displays overall results for the current and preceding runs. 

Figure 6-1 Overall HP QTP Results 

 
Results for all MITE for UFT objects contain snapshots if you have set up Active Screen capture when 
recording the script. The node for a successful checkpoint displays a check mark. 

Figure 6-2 Checkpoint Results 

 

Highlighted element 
selected as 
checkpoint  

Checkpoint 
object in 
results tree 
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Figure 6-3 Results for Browser Object 

 

Figure 6-4 Results for Page Object 
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Figure 6-5 Results for Click Action 

 

Figure 6-6 Results for Select Action (Drop-Down List) 

 

Value selected in 
drop-down list  

Button clicked  
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Figure 6-7 Results for Data Entry 

 

6.2.2 MITE Results 

A list of MITE runs is available in the MITE test list layout  in HP QTP. For the runs listed here to 
persist after the current HP QTP session, set the saverun property of a script’s MITE Browser object to 
True. 

Expand the tree for a run and select the bottom node: summary run results are displayed to the right. 

Figure 6-8 Test List with Summary Results for Selected Run 

 

Field for data entry  

Value entered 
(encrypted) 

Selected run Pass/fail summary 
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You can select one of several result indicators from the drop-down list in the Test results pane: 

Figure 6-9 Choosing a Result Indicator 

 
The images below show the number of pages visited (2) and the MITE grade (A): 

Figure 6-10 Viewing Different Result Indicators 

 
Runs listed here can be renamed: 

1. Right-click a run and select Rename test.  
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2. Enter a new run name in the dialog box that appears and click OK. 

 

To view detailed results, with a run selected from the test list, switch to the run results layout . 

Figure 6-11 Detailed Run Results with Page Snapshot 

 
For a selected page, you can also view the DOM tree (shown below). You can search for any string in the 
DOM. 

Pages visited with 
selected page 
highlighted 

Summary of run results incl. 
MITE score, grade, etc. 

Snapshot of selected page 

Waterfall of downloaded 
objects on all pages 
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Figure 6-12 Results--Page DOM and Element Post Data 

 
For any object selected in the waterfall, you can see the sent and received headers in the HTTP headers 
tab to the right. 

Figure 6-13 HTTP Headers Sent and Received 

 

6.3 Execution on a Different or Multiple Devices 
As MITE scripts are based directly on the web elements underlying web content, a script recorded on one 
device can be executed on another.  

To execute a script on a different device from the one it was recorded on: 

1. Open the script you want to execute. 

Selected page 

Selected object Sent and received 
HTTP headers 

Selected page 
DOM of selected page 

Selected element 
on selected page 

POST data for selected 
element 
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2. Open the script data table: View > Data Table. 

3. Select the device profile you want to execute on in the device library. 

4. Right-click and select Copy device details. 

 
5.  Paste (Ctrl+V) the device details in a data table row. 

 
6. Copy the contents of column F. 

7. Open the object repository. 

8. Select the deviceid property of the MITE Browser object. 

 
9. Paste the copied device ID and close the object repository. 

10. Run your script; it will now be executed on the selected device. 

A script can also be executed one device at a time, on a group of several devices. As before, the device 
list is specified in a script data table. The script’s MITE Browser object is set to read device IDs from 
column F of the data table: 
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1. Open the script you want to execute. Ensure that the data table is visible: View > Data Table. 

2. From the device library, select the first device profile you want to execute on. 

3. Right-click and select Copy device details. 

4.  Paste (Ctrl+V) the device details in a data table row. 

5. Repeat these steps for as many devices as you want to add to the device list. 

 

NOTE You can also filter the device library by any string, e.g., Android, and then Ctrl-click to select 
multiple devices. You can copy and paste all device details together. 

6. In the object repository, select the deviceid property of the MITE Browser object. 

7. Click in the Value column and then click the  button to configure the value.  

8. Make the following selections in the dialog box that appears and click OK: 

a. Select the Parameter radio button (ensure that Data Table is selected as the value). 

b. Choose F from the Name drop-down list. This sets the value of deviceid to column F of the 
data table. 

c. Select Global sheet. 

 
9. Run your script; it will now be executed sequentially on each selected device. 

HP QTP results for a multi-device script show execution on each device as an iteration. 
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Figure 6-14 HP QTP Results for Multi-Device Execution 

 
MITE summary results in the test list show the outcome on each device. 

Figure 6-15 MITE Summary Results for Multi-Device Execution 

 

Three main branches 
for a 3-device 
execution 

# iterations 
= 3 

Selected multi-device 
run 

Summary results on 
each device 
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